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INTRODUCTION

The SMX-M7xx Series Cameras are megapixel CMOS cameras with USB2.0 interface
suitable for scientific and industrial applications. The cameras are designed for
capturing, streaming and storing high quality digital images.

The cameras are available in three modifications:
® SMX-M71M (1.3 Megapixel, monochrome)

® SMXM72 (2 Megapixel, color)

® SMX-M73 (3 Megapixel, color)

All the SMX-M7x cameras feature:

® Communication interface - USB2.0

@ External trigger - 6 pin Hirose connector

® Form factor - a duralumin housing with C-mount
SMX-M7x cameras provide the benefits:

@ High speed

@ No external power supply required

® Ease of use

® Compactsize

Programmable functions include viewport window settings, adjustable exposure time
and gain, selectable sensor clock frequency and image decimation, flipping the image
horizontally and vertically.

The SMX-M7xx Series cameras can be used in microscopy, video conferencing,
webcasting, surveillance and security systems, etc.

Introduction:
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INSTALLATION AND
UPDATE

Before installing the camera software, install a USB2.0 adapter if needed. Install all
required drivers. Installation of the USB2.0 adapter is beyond the scope of this
document.

System Requirements

Operating System XP SP1+/2003/Vista/2008/7, recommended: Windows 7 or XP SP1 and higher

Processor Intel Pl or higher, recommended: Intel Core 2 Duo
Performance Minimum 300 Mflops, recommended: 400 Mflops or higher
Memory 256 MP for XP (512 MB for 2008/Vista/7), recommended: 512 MB (1024 MB)

Recommended: Intel integrated Host Controller, not recommended: VIA-based

USB 2.0 R
USB 3.0 Host Controller is also supported
Video 8 MB memory, recommended: GeForce 4xxx/Radeon 9xxx or higher
Installation

To install the SMX-M7xx camera application software:

1 Run the SMXM7X-<version>.exe file downloaded via the URL provided by Sumix
Corporation.

2 Welcome to the SMX-M7x USB 2.0 Camera Software Setup Wizard starts. The wiz-
ard will guide you through the software and hardware drivers installation. Close all
other applications that are running on your computer and then click the Next button
to continue the installation.

Installation and Update: System Requirements
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5! Setup - SMX-M7x USB2.0 Camera Software =] @ |

Welcome to the SMX-M7x USB2.0
Camera Software Setup Wizard

This will install SMX-M7x USE2.0 Camera Software v2,1310 on
your computer,

It iz recommended that you dose all other applications before
continuing,

Click Next to continue, or Cancel to exit Setup.

[ MNext = ]| Cancel |

Figure 2-1 Welcome to the SMX-M7x Camera Setup Wizard

3 Inthe License Agreement box, read the license. Then select | accept the agree-
ment and click Next.

[5T Setup - SMX-M7x USB2.0 Camera Software

License Agreement
Please read the following important information before continuing.

Please read the following License Agreement. You must accept the terms of this
agreement before continuing with the installation.

1. LICENSE AGREEMENT -

This software End User License Agreement (hereinafter referred to as EULA) is a
legal agreement between you, and Sumix Corporation (hereinafter referred to as
AIUTHOR) for the SMYX-M7x IUSB2.0 Series Camera Software incuding any
endosed documentation and/or accompanying items (hereinafter referred to as
SOFTWARE).

This AGREEMENT states the terms and conditions upon which AUTHOR offers to
license the SOFTWARE.

This agreement is binding upon you as well as anyone taking any action with ~

(@ I accept the agreement

1 do not accept the agreement

| < Back |[ MNext = ]| Cancel

Figure 2-2 License Agreement dialog box

4 The wizard starts to check your system information. Upon completion, a table with
check results is displayed in the System Information box.

Installation and Update: Installation
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ﬁl Setup - SMX-MT7x USB2.0 Camera Software

System Information
System Information collects your system configuration information.

05 Microsoft Windows 7 Ultimate (x64)
Processor(s) |Intel(R) Core(TM)2 Due CPU T9400 @ 2.53GHz ~2534 MHz (2 CPU)
Performance |730 Mflops
Memory 2045 MB
UsB2.0 USB2.0 controller found
Video MNVIDIA GeForce 9600M GT, 512 MB

I < Back ” MNext = ]l Cancel

I

Figure 2-3 System Information box

5 Do one of the following, depending on the results of the check:

® click the Next button if all table cells with system parameters are green (the
parameters satisfy the software requirements)

® update your system if at least one cell is red - such configuration is not recom-

mended

® update your system if at least one cell is yellow, otherwise the technical character-

istics declared for the camera will not be achieved.

To see the recommended system requirements, click the Requirements button in the
System Information dialog box:

ﬁl Setup - SMX-MT7x USB2.0 Camera Software

System Information
System Information collects your system configuration information.

(0]

XP SP1-+f2003/Vista /20087, recommended Win7 or XP SP1+

Processor(s)

Intel P4 or higher, recommended Intel Core 2 Duo

Performance

Minimum 300 Mflops, recommended - 400 Mflops or higher

Memory

XP - 256 MB (512 - 2008/Vista), recommended 512 ME (1024 MB)

USB2.0

Recommended Intel integrated controller, not recommended VIA-base|

Video

8 MB memory, recommended GeForce 4xooqRadeon 9xxx or higher

E=R Nl

I < Back ” MNext = ]l Cancel

I

Figure 2-4 Recommended system configuration

Installation and Update: Installation
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6 In the Select Destination Location box, click Browse to change the folder in which
the SMX-M7x camera application software will be installed, or leave the one sug-
gested by the wizard. Click Next.

ﬁl Setup - SMX-MT7x USB2.0 Camera Software

Select Destination Location
Where should SMX-M7x USE2.0 Camera Software be installed?

| Setup will install SMX-M7x USE2.0 Camera Software into the following folder.

To continue, dick Next. If you would like to select a different folder, dick Browse.

:\Program Files (%86 i \SMX-M7x USB2.0 Camera| Browse...

At least 10,9 MB of free disk space is required.

| < Back |[ MNext = ]| Cancel

Figure 2-5 Select Destination location box

7 Inthe same way, in the Select Start Menu Folder box, leave the suggested location
or specify the folder you wish. Click Next.

5! Setup - SMX-M7x USB2.0 Camera Software =] @ |

Select Start Menu Folder
Where should Setup place the program's shortouts?

= i Setup will create the program's shortcuts in the following Start Menu folder.

To continue, dick Next. If you would like to select a different folder, dick Browse.

[Sumix \SMX-M7x USB2.0 Camera) Browse...

| < Back |[ MNext = ]| Cancel

Figure 2-6 Select Start Menu Folder box

8 In the next wizard box select additional icon that you wish to create and choose
whether you want to launch the application right after the installation, or not.

Installation and Update: Installation
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ﬁl Setup - SMX-M7x USB2.0 Camera Software

Select Additional Tasks
Which additional tasks should be performed?

Select the additional tasks you would like Setup to perform while installing SMX-M7x
USB2.0 Camera Software, then dick Mext.

Additional icons:

/| Create a Desktop icon
Create a Quick Launch icon
Create a Taskbar icon

Run application:

Launch SMX-M7X USB2.0 Camera Application

E=R Nl

| < Back |[ Mext = ]| Cancel

Figure 2-7 Select Additional Tasks box

9 In the Ready to Install step, view the options you selected and click Install.

ﬁl Setup - SMX-M7x USB2.0 Camera Software

Ready to Install

Setup is now ready to begin installing SMX-M7x USB2.0 Camera Software on
your computer,

Click Install to continue with the installation, or dick Back if you want to review or
change any settings.

Destination location:
C:\Program Files (x88)\5umix\SMX-M7x USB2.0 Camera

Start Menu folder:
Sumix\SMX-M7x USE2.0 Camera

E=R Nl

| < Back ” Install

| | Cancel

Figure 2-8 Ready to Install box

10 The wizard will start to install the application on your computer.

Installation and Update: Installation
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15 setup - SMX-M7x USB2.0 Camera Software

Installing

Please wait while Setup installs SMX-M7x USB2.0 Camera Software on your
computer,

Finishing installation. ..

Figure 2-9 Installing box

During the installation, the system will ask you whether you want to install the device
software. Press Install to proceed.

[=7] Windows Security @
Would you like to install this device software?

Mame: Sumix Corporation Imaging devices
37"5 Publisher: Sumix Corporation

Always trust software from "Sumix Corporation”. Install ][ Den't Install

"\ij' You should only install driver software from publishers you trust. How can I decide
which device software is safe to install?

Figure 2-10 Windows Security box

11 When done, click Finish. The software has been successfully installed.

Installation and Update: Installation
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5! Setup - SMX-M7x USB2.0 Camera Software =] = | &=

Completing the SMX-M7x USB2.0
Camera Software Setup Wizard

Setup has finished installing SMX-M7x USB2.0 Camera
Software on your computer, The application may be launched
by selecting the installed icons.

Click Finish to exit Setup.

Figure 2-11 The last installation step

If you face problems during the camera installation, see “Troubleshooter” on page 18.

The installation of the camera driver will be completed when you first connect the
camera to the computer’s USB port.

Driver Update

The camera application software is constantly developed and improved. When a new
version is available, the customers are notified and a new installer file is sent to them.

The update procedure is exactly the same as the installation described in the previous
section. Simply run the new installer SMXM7X<version>.exe and follow the wizard
(see “Installation” on page 9).

When a new camera driver version is available, you can update it via the Windows
device manage.

To update the camera driver:

1 Connect the camera to the computer.

2 Open the Device Manager window in the Control panel window.

3 Double-click Imaging devices.

4 Right-click SMX-M7x Series USB2.0 Camera and select Update Driver Software...

Installation and Update: Update
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=y Device Manager EI@

File Action View Help
e A sER P I T

a 7 HP-HDX-16-001 it
b @ Batteries

. 2| Biometric Devices

18} Validity Sensor

,..8 Bluetooth Radios

bl Computer

:, -y Disk drives
- B Display adapters
} DVD/CD-ROM drives

m

4% Human Interface Devices
b g IDE ATA/ATAPI controllers
b @ IEEE 1394 Bus host controllers
Alj Imaging devices

= Brother MFC-7820N LAN
’g HP Webcam

’g SMX-MTx Series USB2.0 Camera

<= Keyboards Update Driver Software...

> ﬂ Mice and other peinting devices Disable

- Monitors .

- Uninstall

"-'-." Metwork adapters

a -5 Other devices Scan for hardware changes

|y Base System Device

!5 Base System Device Properties
In Base Svstem Device

Launches the Update Driver Software Wizard for the selected d

Figure 2-12 Updating the camera driver

5 Follow the easy-on-screen instructions. On the first step, select Browse my com-
puter for driver software.

&) U Update Driver Software - SMX-M7x Series USB2.0 Camera

How do you want to search for driver software?

= Search automatically for updated driver software
Windows will search your computer and the Internet for the latest driver software
for your device, unless you've disabled this feature in your device installation
settings.

- Browse my computer for driver software
Locate and install driver software manually.

Cancel

Figure 2-13 Updating the camera driver: step1

Installation and Update: Update
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6 On the next step, browse for the location on your computer where the driver is saved
and click Next.

@ |l Update Driver Software - SMX-M7x Series USB2.0 Camera
Browse for driver software on your computer

Search for driver software in this location:

il Browse...

[¥] Include subfolders

< Let me pick from a list of device drivers on my computer
This list will show installed driver software compatible with the device, and all driver
software in the same category as the device.

| Mext || Cancel

Figure 2-14 Updating the camera driver: step 2

7 The system will start installing the driver. In the end, a message that the installation is
successful will appear. Press Close to finish.

Removal

To remove the camera application software, use the Add/Remove Programs section in
the Windows Control Panel. Remove the application according to the general
Windows application uninstallation rules.

Alternatively, you can click the uninstallation shortcut in the application folder (Start >
All Programs > Sumix > SMX-M7x USB2.0 Camera> Uninstall SMX-M7X USB2.0
Camera Software) and follow the uninstallation wizard.

After removing the software, you need also to remove the camera driver.
To remove the camera driver:

1 Connect the camera to the computer.

Open the Device Manager window in the Control panel window.
Double-click Imaging devices.

Right-click SMX-M7x Series USB2.0 Camera and select Uninstall.

Confirm removing the driver: check the Delete the driver software for this device
and click OK.

ui » W N

Installation and Update: Removal
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Confirm Device Uninstall @

=  SMX-M¥ Series USB2.0 Camera

Waming: You are about to uninstall this device from your system.

Delete the driver software for this device.

[ ok ][ cance |

Figure 2-15 Driver removal confirmation

6 After the driver is uninstalled, the SMX-M7x Series USB2.0 Camera will disappear
from the Imaging Devices section of the Device Manager.

Troubleshooter

Note:

If you face problems with installation and detection of the camera, use this
Troubleshooter. If you face problems that are not described below, contact Sumix
Technical Department.

Tasks and problems in this section are demonstrated in Windows XP operating system.

Camera Was Not Detected or Recognized

If after connecting the camera to your computer the system does not detect it: there is

noicon % on the Taskbar or the camera was not recognized by the system:

L\-. USE Device Mot Recognized

One of the USE devices attached ko this computer has
malfunctioned, and Windows does not recognize it
For assistance in solving this problem, click this message.

| %o

Try doing the following:

® Check if the device was installed successfully: open system folder WINDOWS\
system32\drivers and check if there is the SMXM7X.sys file (normally it is located on
the C: hard disk). If not, run the Driver installation again. Be sure that no camera is
connected during installation.

@ |If the problem still persists, manually save the SMXM7X.sys file to the \WIN-
DOWS\system32\drivers folder (the SMXM7X.sys file is located in the \Sumix\SMX-M7x
USB2.0 Camera\Drivers folder).

If the problem still persists, try one of the following:

Installation and Update: Troubleshooter
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® Reconnect the camera.

® Use other USB2.0 port of your computer - the problem might be due to the USB2.0

port malfunction.

® Use another USB2.0 cable - the problem might be due to the USB2.0 cable malfunc-
tion.

® Connect other SMX-M7x camera (if any) to the same USB2.0 port - the problem might
be due to the camera malfunction.

® Disconnect the camera and restart your computer.

If any of the above steps did not help and the device is not recognized yet, try the

following:

1 Connect the problematical camera to the computer.

2 Open the Device Manager window (right-lick My Computer desktop icon, select
Properties, select Hardware tab, and then click Device Manager).

3 In Device Manager, double-click Universal Serial Bus controllers.
In Device Manager, select one of the following:

® Imaging devices> SMX-M7x Series USB2.0 Camera with Warning status, if it is
available there:

%De\rice Manager E]@

File  Action Wiew Help

; .
F ] @J

mFS 2 A=K

MAaRY

o Computer
“g# Disk drives

% Display adapters

& DVDYCD-ROM drives
=) Floppy disk controllers
+ g Floppy disk drives
+ {9 Human Interface Devices
+-{=y IDE ATAJATAPT controllers
=8 Imaging devices

=" SME-M7Tx Series USB2.0 Camera;

+| -z Keyboards
+ 1 ) Mice and other pointing devices
+ & Monitars
+ - E8 Network adapters
+ & Ports (COM &LPT)
+ ﬂ Processars
+ @, sound, video and game controllers

+ System devices
+ Universal Serial Bus controllers

Figure 2-16 Device Manager: the SMX-M7x camera with Warning status

® Universal Serial Bus controllers> Unknown device:

Installation and Update: Troubleshooter
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% Device Manager

File  Action Wiew Help

e 2 8

Mice and other pointing devices |

% Maonitors i
Metwork adapters

¥ Parts (COM & LPT)

3
B
5
m Processars
:

Sound, video and game controllers
¢ System devices

Universal Serial Bus controllers
&2 Generic USE Hub

=
4]
0
4
4
4
4

e Intel(R) S2801EE USE Universal Host Contraller - 2402
= Inkel{R) 82801EE USE Universal Host Controller - 2404

Intel{R) 82801EE USE Universal Host Controller - 2407

= Intel{R) 828016 USE Universal Host Controller - 24DE

= Intel(R) 52801EE 1USE2 Enhanced Host Contraller - 2400

= |JSE Root Hub
= 1ISE Root Hub
= 1ISE Root Hub
= 1ISE Root Hub

Figure 2-17 Device Manager: the SMX-M7x camera is detected as Unknown device

5 Right-click and select Update Driver...:

%De\n’ce Manag =Jo/Ed
File  Action Wiew Help

g 2 a=x
+ Eg Manitars [Ead
+ - B8 Network adapters
- F Ports (COM&LPT)
+ m Processors
+ E) Sound, video and game controllers
+ Syskem devices
= é Universal Serial Bus controllers
"-_' Intel{R) 82801EE USE Universal Host Controller - 2402
Intel{R) 82801EE USE Universal Host Controller - 2404
Intel{R) 82801EE USE Universal Host Controller - 2407
Intel{R) 82801EE USE Universal Host Controller - 24DE
= Standard Enhanced PCI ko USE Host Controller

s, | inknoin Devii— 4,
= ERnesE Update Driver... B

b LISE Ract Hub| ‘

3 Disable

USE Rook Hub | Uninstall

= LISE Rook Hub | |
1USE Rk Hubé Scan for hardware changes

= USE Root Hub|  Properties |

Launches the Hardware Update Wizard for the selected device,

Figure 2-18 Device Manager: Updating the SMX-M7x camera driver

Run the Hardware Update Wizard the same way as the Found New Hardware Wizard
by choosing the Install the software automatically (Recommended) option:

Installation and Update: Troubleshooter
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Hardware Update Wizard

I Thiz wizard helpz you install software for:

Shdx-t 7% Series ISB2.0 Camera

{ ') If your hardware came with an installation CD
= or floppy disk. insert it now.

‘what do you want the wizard to do?

@i
(O Install fram a list or zpecific location (Advanced)

Click Mest to continue.

| < Back ][ Mest » ]I Cancel ]

Figure 2-19 Hardware Update Wizard: the Welcome window

6 If some problems occur during the manual hardware installation, read the next sec-
tion of this Troubleshooter.

Cannot Install the Hardware

If the Found New Hardware Wizard\Hardware Update Wizard failed to install the
hardware (the wizard that starts after the first connection of the camera or the Wizard
that starts for updating the hardware; failure occurs after you browse to the files needed
for the installing),

Found Mew Hardware Wizard

.5‘1 Cannot Install this Hardware
The hardware was not installed becauze the wizard cannot find

the neceszary software,

when this computer connects to the Internet, Windows Update
will zearch for the right software and notify you if it becomes
available.

irJ Click Back if you have installation media such as a
" CD-ROM, or if you know the location of the software,

3 Click Finizh to go to Help and Support Center for further
. help installing thiz hardware,

[ < Back ” Finizh ][ Cancel ]

Figure 2-20 Found New Hardware Wizard: Cannot install this Hardware

try doing the following:

1 Click Back in the Found New Hardware Wizard and select Install from a list or spe-
cific location (Advanced).

2 C(lick Next.

Installation and Update: Troubleshooter
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Hardware Update Wizard

. Thiz wizard helpz you install software for:

Shdx-t 7% Series ISB2.0 Camera

{ 'j If your hardware came with an installation CD
= or floppy disk. insert it now.

1.

what do you want the wi

O ln

ol

zoftware automatically [Fecommended]

Click Mest to continue.

e e

Figure 2-21 Found New Hardware Wizard: Installing from a list or specific location (Advanced)

3 Select Search for the best driver in these locations.
Check the Include this location in the search box.

5 Browse to the Drivers folder - on the SMX-M7x Camera CD or in the Sumix\SMX-M7x
USB2.0 Camera folder (located on the hard disk where you installed the SMX-M7x
Camera Software, normally it is the C:\Program Files\Sumix\SMX-M7x USB2.0
Camera).

6 Click Next.

Hardware Update Wizard

Please choose your search and installation options. o
3.
(3) Beatth for the best driver in these locations.

Uze the check boxes below to limit or expand the default search, which includes local
4. pathz and removable media. The best driver found will be installed.

\E Search removable media (floppy, CD-ROM. ) 5.
Include this location in the search: /
gram Files\Sumis\SMX M7 USBZ.0 Camefs\Driver

(O Don't search. | will choose the driver to install

Chooze thiz option to select the device driver from a list. Windows does not guarantee that
the driver you chooze will be the best match for your hardware.

6.

[ < Back Mest » ][ Cancel ]

Figure 2-22 Installing from a list or specific location: specifying location

7 Inthelist, select the last item.
8 Click Next.

Installation and Update: Troubleshooter
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Found Mew Hardware Wizard

Pleasze select the best match for your hardware from the list below. .

@ ShAx-b 7% Series LISB2.0 Camera

7.

Drescription Wergion M anufacturer Location
be-bd 7 Series USB2.0 Camera 1.79.800.700  Sumix Corporation  c:windo

SMX-M?R Seriez USB2.0 Camera  1.79.800.700  Sumix Corporation  c:windo

This driver iz not digitally signed!
Tell me why driver signing is impartant

[ < Back ” ﬂ‘exb ][ Cancel ]

Figure 2-23 Install from a list or specific location: selecting file among the Wizards's search results

9 Wait till the wizard installs all files.
10 Click Finish if installation passed successfully.

Installation and Update: Troubleshooter
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GETTING STARTED

Recommendations on the Camera Connection

Most computers have both front and back USB2.0 ports location. We do not
recommend using the front USB2.0 port of your computer since it is not directly
connected to the computer's USB Host Controller.

7 front USB2.0

port
1 >

PCIUSB2.0

Integrated USB2.0
controller

As shown on the picture above, the front USB2.0 port is connected to the USB Host
Controller by long cables inside computer, meanwhile back USB2.0 port is connected
directly to its controller at the back panel of computer.

So, when connecting the camera to the front USB2.0 port the device might not work
properly. We recommend to use the back USB2.0 port to avoid problems with the
camera work (see the picture below).

Note:  Design and configuration of the front USB2.0 port location shown on the pictures above might differ from yours.
The pictures' goal is only to show how the front USB2.0 port is connected to its controller

Getting Started: Recommendations on the Camera Connection
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Plugging in the Camera

Connect SMX-M7x camera with USB2.0 cable.

LN

A. .
USB cable ~ MiniUSB

U

Connect the other end of the USB cable to the back USB2.0 port of your computer.

> back USB port
Hy s
\\
.’I.

USE cable A

e |

)

Installing Lens

To use a lens with the camera, remove the cover from the camera and install a lens as
described below.

It is recommended to remove the cover and install a lens (as well as remove a lens and
put on the cover) when the camera is faced down, to prevent the sensor contamination.

To install a lens:
1 Face the camera down.
2 Remove the camera cover.

3 Screw the lens in (see the picture below):

Getting Started: Plugging in the Camera
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— g Remove the
+ cover rel;tstikr]\e *

| | 8 L

To remove the lens
1 Face the camera down.
2 Screw the lens out.

3 Puton the cover (see the picture below):

Getting Started: Installing Lens
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Screw the
— Put on
lens out

the cover *

I 1 | I
1] 1]

Note:  Before screwing the lens in or putting on the cover, make sure that the surfaces are free from dust

When you remove the cover, put it facing down to keep dust out

|

Installing Driver Software

After you connect the camera to the USB port of you computer, a Found New
Hardware message will appear in the notification area of the task bar, and Windows will

install the hardware driver. When the installation is finished, a message will appear in
the notification area:

Getting Started: Installing Driver Software



SMX-M7xx Series USB2.0 Camera User Guide

=

== SMX-M7x Series USB2.0 Camera

i - - -
=¥ Device driver software installed successfully.
.,

=

Figure 3-1 Notification about successful camera installation

Note  Ifyou experience problems during the driver software installation, refer to the Installation Troubleshooter and
learn how to fix such problems (see “Troubleshooter” on page 18).

Starting the Application

After the camera hardware has been installed, you can start the application.

To start the camera application:

Click Start > All Programs > Sumix > SMX-M7x USB2.0 Camera > SMX-M7x USB2.0
Camera Application Program. If during the installation you chose to install a desktop
icon and/or a quick launch icon, you can also click the icon to launch the application.
The SMX-M7x camera application will start with its main window.

The SMX-M7x camera application consists of the following parts:

@ Main window which contains the main functions. On the top of the main window,
there is an application toolbar:

&Y SMX-M7x Series USB2.0 Camera | = || = |[meal]

File Edit Device Help

® || @ |&|de
Sensor Control
— Exposure Gain Frequency
11,85 ms 12,0 180 12,0 18,0 ,—_|
40MHz -
—— Decimation
11 hd
—— Wiewwport [pix] —
T T T T 1024 1 768
at 0, 768
Al R G B
I~ Lock Ratio

Image Carrection | Coalor Balance | Colar Canrectian |
[~ Enable _ Best D efault

Brightresz 0
Contrast 0
Gamma [ 1.00

Snapshot

[~ Loop
Timeout zec) |1 %] [~ Estemal Trigger

SMX-M73 Color Ready Zoomlx |36 fps

Figure 3-2 SMX-M7x application main window

Getting Started: Starting the Application
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@ Histogram which reflects all color settings of the camera.

To open the histogram:
Press the h button on the keyboard or select Histogram from the Device menu.

Histogram @

V'S

Min: 45 Avg : 100,63 Max: 179

Figure 3-3 Camera histogram
Note:  The histogram window is empty when the video is not started.

@ Device Settings window contains the camera settings.

To open the Device Settings window:

Select Settings from the Device menu or press Alt+s on the keyboard.

Device Settings @

Camera Info
S+ 73 Color USB2.0 Camera Cloze
Max Resolution: 2048x1536
Device ID: 1794.11.6.12.30

Color Mode Flip Image Average Frames

" Monochrome . + Disable
[ Horizontal || ~ | 2ot N frames

" Pack M frames

+ Mearest Color

" Bilinear ™ Vertical
" Laplacian Frames: |10 %
External Trigger Polarity Max Exposure

[~ Limit Max Exposure

Megative -
egative "IDD— e

Black Level Calibration ' alue

i
T

I Direct Access Ta Driver Frame Memary  FrameRate ...
Iv &utowhite Balance Hardware
Connector...

Iv &uto white Balance Software
X Median Filter
[ Video on Progiam Startup [ Software Median Filter

Limit Gain 10
) e el Median Filter Type 0

™ Enable Image Comrection
[~ 10 bit mode

Figure 3-4 Device Settings window

® Video mode window which shows a live view from the camera and reflects all set-
tings of the image

Getting Started: Starting the Application
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Q Zoom 1x Ellﬁl

Figure 3-5 Video mode window

To start video from the camera:

Click the Start Video button in the toolbar:

i
OR
Select Start Video from the Device menu.

Note:  Todisplay video right after you enter the application, select the Video on Program Startup check box in the
Device Settings window. Then you will not need to click the Start Video button.

If the Start Video button is not active, go to the Device menu in the main window,
choose Switch Multiple... and select the connected camera.

Switching Between Cameras

If you have more than one SMX-M7x camera connected to your PC, the camera
application allows you to switch between them or make sure the application operates
the required camera.

To switch between multiple cameras:

1 Inthe Device menu of the application’s main window, select the Switch Multiple
command.

Getting Started: Switching Between Cameras
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2 The Choose a Camera window will appear.

Q Choose a Camer... EI@

alor Camera [1734]
lor Camera [3669]

(] 8 | Cancel

Figure 3-6 Switching between cameras

3 Inthe list of the present cameras, select the desired one and click OK.

Note: When two or more cameras run on the same computer, frame rate of each camera decreases.

Viewing Camera ID

The camera ID is shown on the top of the Device Settings window.

Device Settings @

Camera Info
S+ 73 Color USB2.0 Camera Cloze
Max Resolution: 2048x1536
Device ID: 1794.11.6.12.30

Figure 3-7 Camera ID

Reducing CPU Load

You can reduce CPU load by enabling the Direct Access to Driver Frame Memory
option at the bottom of Device Settings window.

I¥ Direct Access To Driver Frame Memong  FrameRate ...

™ &uto White Balance Hardware
Iv &uto white Balance Software

|

Connector...

Figure 3-8 Direct Access to Driver Frame Memory checkbox

See APl documentation for the details on how to provide direct pointer to the driver
frame memory instead of copying the frame to the user buffer.

Getting Started: Viewing Camera ID



TUNING GUIDELINES

Initial Settings

Check if the Start Video button on the camera application’s toolbar is enabled:

|

If

it is not enabled, check the list of all available cameras in Main menu > Device >

Switch Multiple... If the list is empty, check if the camera is connected and if the driver

is

installed correctly.

The illumination of the camera’s image depends on the values of frequency, exposure,
gain, the image dimensions (resolution) and decimation factor.

The recommended initial settings are:

@ Gain and Exposure sliders are in the lowest position
® Decimationis 1:1
@ Viewport size is 800 x 600 (the Viewport settings dialog box is activated with the
button on the camera application toolbar or Alt + v on the keyboard)
® Color Mode is set to Bilinear (Main Menu > Device > Settings... dialog box, Color
Mode section)
@ Histogram is active (Main menu >Device > Histogram is selected or h is pressed)
Histogram @
Min: 0 Avg: 1,00 Max: 1

Figure 4-1 Histogram of initial state

® Thelmage Correction tab is selected

® The Enable check box is set

The Brightness, Contrast, Gamma sliders of the Image Correction tab are in the
central position (their values are 0, 1, 1, respectively). To reset the values for all sliders
at one go, click the Default button. To reset one of them, double-click its value at the
right end of the slider bar

The R, G, B sliders of the Color Balance tab are in the central position (their values
are 1, 1, 1, respectively). To reset the values for all sliders at one go, click the Default
button. To reset one of them, double-click its value at right end of the slider bar

Tuning Guidelines: Initial Settings
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Note:

@ The Brightness, Contrast, Saturation sliders of the Color Correction tab are in the
central position (their values are 0, 1, 1 - respectively). To reset the values for all slid-
ers at one go, click the Default button. To reset one of them, double-click its value at
right end of the slider bar

The slider values will affect the image, only if the Enable box is checked.

Tuning Light in the Image

Color Tuning

To tune illumination, install a lens (see “Installing Lens” on page 26).

To tune light in the image:
1 Use maximum diaphragm aperture of your lens.
2 Try to get enough light using the Exposure slider.

3 If the Exposure slider is at maximum and more light is needed, decrease frequency
(it will enlarge the exposure interval).

If ilumination is not enough, use the Gain group of sliders (All, R, G, B).
5 Press e on the keyboard to adjust the exposure automatically.

Histogram @
Min: 12 Avg: 2847 Mazx: 247

Figure 4-2 Histogram after illumination is tuned

6 If the image is still too dark, you can also change black level:
a. Open the Device Setting window by pressing Alt+s.

b. Go to the Black Level Calibration Value control and move the slider until the
image becomes as bright as you need.

Black Level Calibration alue

I
T

Figure 4-3 Black Level Calibration control

To tune color of the image:
1 Putawhite object (for example, a piece of paper) in front of the camera.

2 Perform White Balance (Hard): select Device > White Balance (Hard) or press
Alt+w. It will balance the RGB components of white at the hardware level.

Tuning Guidelines: Tuning Light in the Image
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3 Select Main > Device > White Balance (Soft) item or press w on the keyboard (color
balance at software level).

4 On the Image Correction tab of the main window, set Brightness to 127 and Con-
trast to 64.

5 If the colors are still faint, make sure that the Image Correction tab is active and click
the Best button.

To control the color components, use the R, G, B sliders of the Color Balance tab and
the Brightness, Contrast and Saturation sliders of the Color Correction tab.

Histogram @
Min: 1 Avg: 12,28 Max: 23

Figure 4-4 Histogram after performing White Balance (Soft)

Histogram @
Min: 0 Avg: 43,36 Mazx: 255

Figure 4-5 Histogram after the Best button is applied

Note:  The Best button should be used every time when light conditions change

Contrast Tuning

Activate the Histogram (H), activate the Image Correction tab, set the Enable check
box and use the Contrast slider to get the histogram as wide as possible (ideal min =0,
max = 255 provided there are no red points at the extremities of the histogram
window).

Sensor Controls

The sensor control options are located in the Sensor Control section of the application
main window. They are as follows.

Tuning Guidelines: Contrast Tuning
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Exposure

Gain

Note:

Sensor Control
— Exposure Gain Frequency

4,33 ms 16 16 16 16 J0MHz -

—— Decimation

1:3 hd
—— Wiewwport [pix] —
2040 = 1536
rrrnr at0.0
'|— Al R G B
I~ Lock Ratio

Figure 4-6 Sensor controls

The exposure parameter defines time during which the sensor will consume light
energy before starting to record data.

Use the Exposure slider to adjust the camera exposure time manually. The current
exposure time in milliseconds is displayed above the control. This value depends on
viewport height, decimation and sensor frequency.

If you need to set exposure even higher than the maximum slider value, use the Max
Exposure control in the Device Settings window. Check the Limit Max Exposure box,
enter new limit value and press Set.

External Trigger Polarity Max Exposure
m [ Limit Max Exposure
ositive ¥
100 ms Set

Figure 4-7 Max Exposure control

To tune exposure automatically:

In the Device menu select the Auto Exposure command, or press E on the keyboard.

Gain can be controlled independently for Red, Green and Blue channels (R, G, B). All
gain sliders control the camera’s hardware gain amplifier. The R, G and B gain sliders
control the software gain for each color channel.

Checking the Lock Ratio check box allows controlling gain on three channels
simultaneously keeping the fixed R; G; B gain ratio.

Use the 'White balance (Hard)' menu item (Device> White Balance (Hard) or Alt+w to
balance the gain of all three channels so they are equally intense.

Auto Exposure is done automatically every time White Balance (Hard) is performed.

In case of SMX-M71M monochrome camera, set gain using the All slider.

Tuning Guidelines: Sensor Controls
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You can limit the maximal set gain value to 10. Use the Limit Gain 10 checkbox in the
Device Settings window.

Iv “ideo on Program Startup
| Lini Gai 11

ge Corection

Figure 4-8 Limit Gain control

If this box is checked, you will not be able to set gain higher than 10.

The Frequency drop-down box provides values for the pixel clock frequency of the
sensor. The lower the frequency, the higher the maximum possible exposure time and
the less the frame rate is. This control defines the frequency of polling the camera for its
image stream.

Use the Decimation drop-down box to decimate (sub-sample) the picture by 2, 3,4 or 6.
The decimation means excluding pixels and rows from the scan process (for example,
every second pixel and second row for the 1:2 decimation). This mode thus allows
viewing the picture at the higher frame rate.

The higher decimation can be used for preview, when the full 1600 x 1200 image can be
displayed as 800 x 600 with the frame rate two times higher.

Viewport is a rectangular area of the sensor on which the image is scanned. It can have
variable size: from the full sensor field of view to the small area of 8 x 8 pixels. The
smaller vertical size (in lines) of the viewport, the faster the scan process and the higher
the frame rate is.

To change the viewport:

1 Press Alt+v on the keyboard

OR

Click the Settings... button below Viewport (pix)
OR

Click the Viewport Settings button on the toolbar:

]

2 The Viewport Settings window will open.

Tuning Guidelines: Sensor Controls
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Viewport Settings @

Cloze

Fredefined
" 320x240
" 400x400
" B40x480
" TEExETE
" 800x600
" 1024x768
" 1280x1024
" 1600x1200
P 9

Offset: = |0 Y |0 Size: ¥ |2048 v |1536

Figure 4-9 Viewport Settings window

3 You can select one of the predefined viewport options and then drag the rectangle
across the full viewport resolution area for the viewport window. You will notice how
the image in the View Mode window changes with the movement.

4 Alternatively, you can change values in the following fields:
@ OffsetX, Y fields with coordinates of the top left corner of the rectangle
® Size X, Y fields with coordinates of the bottom right corner of the rectangle

If the viewport size is smaller than 2048x1536, you can also change it by dragging the
video image in the Video mode window.

Image Correction

The Image Correction controls are designed for setting up the camera brightness,
contrast and gamma. These corrections are programmable with the conversion (lookup)
table of the values. They do not affect any electrical settings of the camera. The gamma
correction is done by the camera hardware.

Image Corection | Caloy

W Enable  Best

Brightress 0
Contragt ©—————— 10
Gamma 100

ce | Color Correction

Figure 4-10 Image correction controls

To use these controls, check the Enable box - the Brightness, Contrast and Gamma
sliders become editable. By default, the values of Brightness, Contrast and Gamma are
set to 0; 0; 1, 00, respectively.

You can restore the default values at any step, just click the Default button on the
Image Correction tab.

Tuning Guidelines: Image Correction
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Click the Best button to automatically achieve the optimal combination of brightness,
contrast and gamma instead of setting them manually. As the result, the application will
transform the look-up table of 8 and 10 bit to increase the dynamic range.

The default values of Image Correction are the most suitable and recommended for performing White Balance
(Hard).

The SMX-M7x camera software does not display changes of the Image Correction look -up table when the Best
button is pressed.

With every change of any Image Correction control, you can view a graphical
interpretation of dependence of the image's changes from the changes of the Image
Correction controls.

Note:

Note:

The Color Balance Controls are designed for the SMX-M72 and SMX-M73 (color)
models to adjust the ratio of the main induced color components (Red, Green and
Blue) of the image. This correction is performed on the software level and does not
affect any electrical settings of the camera.

To use the Color Balance Controls, set the Enable check box on the Color Balance tab
- R, G and B sliders become editable.

Image Corection  Color Balance | Color Correction |
[v¥ Enable D efault | “white: Balance|
R I 0.76
Gr I 1,05
BT I 1137

Figure 4-11 Enabling the Color Balance Controls

Use the White Balance button for white color balancing (the same can be donein
Device> White Balance or by pressing w on the keyboard) on the Color Balance tab.
The Default button returns the color balance controls to their default values: 1.00; 1.00;
1.00, respectively.

Single step of the Color Balance controls is 10 times smaller than R, G, B (Gain) of the
Sensor Controls, so all changes of Color Balance can be performed with more
accuracy than it can be done using R, G, B (Gain) of Sensor Controls.

The difference between White balance (Soft) and White Balance (Hard) is as follows: the White Balance (Soft)
operation is done only on the software level, so it changes the Color Balance controls. The White Balance
(Hard) operation is done programmatically by the camera firmware, so it changes R, G and B (Gain) of Sensor
Controls.

It is not recommended to perform White Balance (Hard) when White Balance (Soft) is already performed. It
may cause the image colors distortion.

Tuning Guidelines: Color Balance
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Color Correction

The Color Correction Controls are designed for the SMX-M72 and SMX-M73 (color)
models to adjust the intensity of the color properties (brightness, contrast and
saturation) of the image. This correction is performed on the software level and does
not affect any electrical settings of the camera.

Check the Enable check box on the Color Correction tab to make the Color Correction
Controls available.

Image Carrection | Color Balance  Color Carrection

r 4 Drefault

Brightness T I 0,00
Contrast T I 1.00
Saturation T I 1.00

Figure 4-12 Enabling the Color Correction tab

Use the Default button to restore the default values of brightness, contrast and
saturation - 0.0; 1.00; 1.00, respectively.

Advanced Sensor Controls

Color Mode

Apart of the controls in the main application window, you can also use controls
available in the Device Settings window. To access the Device Settings window, press
Alt+s on the keyboard or select Settings from the Device menu.

The Color Mode section defines the rules for decoding the stream of source pixels from
the sensor and transforming it into the output image. This control is available for the
SMX-M72 and SMX-M73 color models.

Device Settings @
Camera Info

S+ 73 Color USB2.0 Camera

Max Resolution: 2048x1536

Device ID: 1794.11.6.12.30
Color Mode Flip Image Average Frames
" Monochrome . " Disable

v Horizontal || ~ | jot N frames

* Pack M frames

" Bilinear v 2
v Vertical
" Laplacian Frames: |15 %

+ Mearest Color

Figure 4-13 Advanced sensor controls

® The Monochrome mode forces the transformation of the sensor pixels data into
monochrome stream.

® The Nearest Color mode: Bayer matrix from the sensor is transformed into destina-
tion stream using the Nearest Color algorithm (the fastest algorithm that gives the
worst, compared to other algorithms, image quality).

Tuning Guidelines: Color Correction
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® The Bilinear mode: Bayer matrix from the sensor is transformed into destination
stream using the Bilinear algorithm (a slower algorithm that gives better quality).

® The Laplacian mode: Bayer matrix from the sensor is transformed into destination
stream using the Linear Interpolation with Laplacian second-order correction terms
(the slowest algorithm that gives the best quality).

You can flip the image in the Video mode window horizontally and/or vertically. Check
the corresponding boxes in the Flip Image section of the Device Settings window.
Using the flip controls, you can rotate the image without changing the camera position
itself.

Increasing Image Quality

Frame Rate

Note

You can increase the image quality by compensating the random noise of the sensor.
For this purpose, use the Average Frames controls in the Device Settings window.

There are two averaging modes:

@ Last N frames: the currently displayed frame is the average of the last N frames set in
the Frames box. The picture is updating every frame

® Pack N Frames: the currently displayed frame is the average of the last N frames set
in the Frames box. The picture is updating every N-th frame.

Use the averaging only for static pictures. Displaying moving objects in the average mode will lead to the image
blurring.

You can change the frame rate for the current sensor parameters (for example,
frequency or viewport) using the FrameRate Control button in the lower part of the
Device Settings window.

To change frame rate:
1 Open the Device Settings window by pressing Alt+s on the keyboard.
2 Press the FrameRate Control button.

Black Level Calibration alue

Frame Rate Control @ —

Set Default | Set Maximum| Connector...

Frarne Fiate: |2A0EEE

|

Figure 4-14 The Frame Rate Control window

3 The Frame Rate Control box opens. By default, it shows the maximum value for the
current sensor parameters.

Tuning Guidelines: Advanced Sensor Controls
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Auto White Balance

Note:

Note:

Note:

4 Typein the new value in the Frame Rate field, then press Set. You will not be able to
set frame rate lower or greater than limits. To check the maximum limit, press the Set
Maximum button.

The Set Default button - if applied, the default value of frame rate for the camera with
current settings will be performed. The default value is flashed in every camera and is
applied automatically when the camera’s settings are changed.

For the Snapshot Loop mode, it is recommended to use the default value of frame rate

As a result, the Frame Rate value will not be greater than the one you entered in the
Frame Rate Control window. Check it when running video: frame rate value will be
displayed at the bottom-right corner of the status bar in the application's main window.

When running the camera on a system that does not meet the minimal requirements (see “System Require-
ments” on page 9), the frame rate value can be less than it is set with the Frame Rate Control option, espe-
cially when running with full viewport and with high frequencies.

These controls are used for the SMX-M72 and SMX-M73 color camera models.

Enable the Auto White Balance Hardware and/or Auto White Balance Software
checkboxes if you want to automatically balance white at the hardware and/or software
levels every time when the picture changes. For Auto White Balance Software
operation, check also the Enable box on the Color Balance tab of the main window.

Iv &utowhite Balance Hardware
S . Connector...
It White Balance Software

Figure 4-15 Auto White Balance checkboxes

For more information on white balance, see “Color Balance” on page 39.

Output Bits per Pixel

Median Filter

If the Use 10 bits box is checked, it enables the software to transmit 10 bitimages from
the camera as opposed to regular 8 bit.

[~ Use 10 Bits

Figure 4-16 10 bit mode check box

The median filter is a technique of removing noise from an image. The SMX-M7x
cameras have two median filters:

® The Software Median Filter which turns on pixel averaging. The brightness of every
single pixel becomes affected by the brightness of its neighbor pixels and the whole

Tuning Guidelines: Advanced Sensor Controls
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image becomes smoother. To enable this filter, check the Software Median Filter
box.

® The Hardware Median Filter which detects and corrects isolated missing pixels in
the output stream of an image sensor. It is based on the prediction of the allowed
range of gray values for a pixel, from the gray values of the neighborhood of that
pixel. To enable this filter, select a type in the drop-down box.

Median Filter
I~ Software Median Filker

Median Filter OFF =

Iedian Filter OFF

Median Filter Type O
tedian Filter Type 1

Figure 4-17 Median Filter controls

There are two types of the hardware median filter:
® Median Filter Type 0, which reduces speckle noise and salt and pepper noise.

® Median Filter Type 1, which preserves edges and is useful when edge blurring is
undesirable.

Saving and Loading Camera Profiles

The SMX-M7x camera application automatically stores most of the camera settings on
exit and restores them on startup. You can also store current settings in profile files
(*.pro) and load them whenever you need. Profiles store frequency, gain, exposure,
viewport, flip, black level and column balancing, and other settings.

To save current camera settings into a profile:

1 Press Ctrl+s.

OR

In the File menu select the Save Profile command.

2 Save Camera Profile box appears. Type in profile title and select a folder where you
want to save the file.

Tuning Guidelines: Saving and Loading Camera Profiles
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Q Save Camera Profile @
Save in: | | test j £k B~

e B L

Recent Places

Desktop
= l.pro
u=a})

Libraries

Computer
“w

Network

File name: |2 j Save |
Save as type: |Pr0ﬁ|e Files {*.pro) j Cancel

Figure 4-18 Saving camera profile

3 Press Save.

To load a profile:
1 Press Ctrl+o or in the File menu, select the Open Profile command.

2 Load Camera Profile box appears. Browse to a folder with profile files and select one
you want to load.

Q Load Camera Profile @
Look in: | | test j EF '

e B L i

Recent Places

Desktop
= l.pro 2.pro
u=a})

Libraries

Computer

“w

Network

File name: |2 j Open |
Files of type: |Pr0ﬁ|e Files {*.pro) j Cancel

Figure 4-19 Loading camera profile

3 Press Open.

Tuning Guidelines: Saving and Loading Camera Profiles



CAPTURING

The SMX-M7x camera application enables you to capture images from the camera and
to store them in BMP or TIFF format files. You can also save files with video that you
record.

Capturing Images

Capture Limits

To capture frames:
1 Start video (press F5 or the button » | Start Video in the toolbar).
2 You can capture a single frame or a frame sequence:

® Forasingle frame press F2 or the button @ in the toolbar

® Fora sequence press F3 or the button &/ in the toolbar.

3 The frame/frame sequence is captured immediately and saved in the folder specified
in Capture Options (see “Saving Options” on page 47).

The Limits section in the Capture Options dialog box allows controlling the capture
parameters. To open the dialog box, press Alt+c on the keyboard.

You can lower the noise level in the frame being captured using the Capture single
frame as average of box. Check the box and type in the number of frame you want to
average.

Lirnits

[v Capture single frame as average of |2 frames

@ Limit sequence counti [2 frames
™ Snapshot Save Only

Capture a frame every 100 ms

Figure 5-1 Limits section of Capture Options

By default, two frames are captured in a sequence. You can increase this value:
1 Check the Limit sequence count to box.
2 Type in the new value in the field near the checkbox.

3 Change the time period for capturing frames in the Capture a frame every field. The
sequence capture interval cannot be less than current frame exposure time. If it is
less, an error message will be displayed when you try to perform a sequence capture:

Capturing: Capturing Images
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Error

i - ) The sequence capture interval (1 ms) is less than current exposure time (8,92 ms).

Please set correct interval in the Capture Options.

Figure 5-2 Message about incorrect sequence capture interval

4 Press OK.

Recording Video

To record a video:

1 Start video (press F5 or the button » | Start Video in the toolbar).

2 To start video recording, press F4 or the button & in the toolbar.

3 Press Shitf+F5 to stop the video stream or click the o] Stop Video button in the
toolbar.

4 The video is recorded and saved in the folder specified in Capture Options (see “Sav-
ing Options” on page 47) as an .avi file.

Saving Video to Memory

You can save video or frames to the core memory. This is done without a delay between
frames. Do the following:

1 Start video.

2 Pressthe =1 Save Video to Memory button in the toolbar or press Shift+F4 on the
keyboard.

Number of frames in the video is set via the Capture Options box. Type in the required
number in the Capture Limit field:

Capture Limit: {100

Figure 5-3 Save Video to Memory section

When you use the Save to Memory option, frames will be saved as image files similarly
to the simple saving (see “Saving Options” on page 47). Video will be saved as a .smx file
which can be replayed and converted to the .avi file with the SMXView utility that goes
with the standard SMX-M7x software package.

Saving video directly to memory can slow down the camera’s output visualization, but
this method insures that no frames are missing in the saved file.

Capturing: Recording Video
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Saving Options

When you capture frames or record a video, they are saved in directory and with file
prefix specified in Capture Options.

To change options for saving frames/video:

1 Open the Capture Options dialog by pressing Alt+c on the keyboard or go to the
File menu and select Capture Options.

SMX-MTx Capture Options @

Picture File Store Folder

C:\UszershlgortDeskioph gg

File Mame Prefizes

Single Frame |FRAME_ Fomat...

. 0 " BMP
equence _
@+ TIFF |NOME =

Video VIDED_ FETE
Snapshot  [gNap_
Limnitz

[~ Capture single frame as average of |2 frames

[v Limit sequence count to |2 frames

I” Snapshot Save Onl
Capture a frame every |1 TS i 4

Capture Limit: {100
(] 8 | Cancel

Figure 5-4 Capture Options box

2 Set the options:

a. Inthe Picture File Store Folder box, change the directory in which you want to
save frames/video or leave the default one.

Note:  This folder will also store snapshots (see "Snapshots” on page 49).

b. Change the prefix that will be assigned to all frame/frame sequence and video
files or leave the default ones. Use the Single Frame, Sequence and Video fields.
The files are named automatically by combining the corresponding File Name
Prefix and numerical value that is calculated by the number of last captured file +
1.

c. Selectimage file format for frames:
® BMP -saves any 8 bit or 10 bit image as 8 bit BMP image.

@ TIFF - saves 8 bit image as 8 bit TIFF image and 10 bit image as 10 bit TIFF image.
Select also compression type: NONE (without compression) or LZW (Lemple-Zif-
Welch - lossless type of compression).

Note:  The selected image format will also be used for snapshots.

3 Press OK.

Capturing: Saving Options
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SNAPSHOTS

Snapshots Basics

The SMX-M7xx Series Cameras can work only in one of the two modes at the same time:
Video or Snapshot. When the camera is not in the video mode, it is possible to take a
snapshot - to capture a stillimage. A snapshot can be triggered by the software, or by
external (with respect to the camera) hardware.

The Video mode is the normal mode when the camera is producing the image data. The
Snapshot mode forces the camera to capture a still image (a single frame).

To take a snapshot from the camera, use the Snapshot section of the camera
application main window. Remember that you need to stop video (Shift+F5) before you
turn on the snapshot mode. To start the snapshot process, press the Snapshot button.

Taking Snapshots Using Software Trigger

Note:

To make a snapshot using the software trigger:

1 Turn the video mode on (press F5 or the Start Video button in the toolbar).

2 Set exposure, gain, viewport, etc.

3 Turn the video mode off (press Shift+F5 or the Stop Video button in the toolbar).
4 Click the Snapshot button in the Snapshot section of the main window.

Snapshot

[~ Loop Shapshaot

SMX-M73 Color Ready Zoom 1x | Stoppe

Figure 6-1 Making a snapshot using software trigger

5 The Snapshot window will open.

In the Video mode, the Exposure slider controls the exposure time for the video. When the video is stopped, the
Exposure slider controls the exposure time of the snapshot.

For continuous sequence of snapshots, use the Loop option. The stream of continuous
snapshots will be displayed in the Snapshot window. This mode can be useful to adjust
the picture parameters for the Snapshot mode.

To make a continuous sequence of snapshots:
1 Turn off the video.

Snapshots: Snapshots Basics
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2
3

4

Check the Loop box in the Snapshot section of the main window.

Click the Snapshot button. Snapshots will continuously appear in the Snapshot
window.

To stop taking snapshots, press Cancel.

Note:  lItis strongly recommended not to change any of the camera’s settings when running the Snapshot Loop mode.
This may interrupt the camera operation.

Taking Snapshots Using Hardware Trigger

To take a snapshot using a hardware trigger:

A 1 AW N

Connect an external device (equipment).

Turn the video mode off (press Shift+F5 or the Stop Video button in the toolbar).
Set exposure, gain, viewport, etc.

Set Timeout (seconds to wait for external triggering pulse).

Check the External Trigger box.

Click the Snapshot button.

Snapshot

[~ Loop N Shapshaot
Timeout [zec) |5 %] W Estemal Trigger

SMX-M73 Color Ready Stoppe

Figure 6-2 Taking a snapshot using the hardware trigger

7

Apply triggering pulse (see “External Trigger Connector Pinout” on page 50).

8 As aresult, the Snapshot window will open if the camera has detected the external

triggering pulse.

If it failed to detect the external triggering pulse, the Snapshot window will not open
and a timeout message will be displayed in the application status bar).

Snapshot
[~ Loop

Timeout zec) |5 %] W Estemal Trigger -

Snapshot Status: Empty Frame (Timed Zoom 1x | Stopped

Figure 6-3 Timeout message in the application status bar

External Trigger Connector Pinout

The following table explains layout of trigger pins..

Snapshots: Taking Snapshots Using Hardware Trigger
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Pin Number Direction Signal Polarity
1 Input Trigger / 'Time Positive
stamp' input
2 Output Programmable -
output
3 Output Programmable -
output
4 Input Trigger / 'Time Negative
stamp' input
5 Output Programmable -
output
6 - Common (Ground) -

Figure 6-4 Camera Connector View, as mounted on the camera

‘Time Stamp’ Feature
@ bit7 bit6 bit5 - three highest bits of line counter
@ bit7 - pin1 of the external connector.
@ bit6 - inverted pin4 of the external connector.
® bit5 - Software controlled. Connected to bit 7 of register#3.
Bit6 of the Register #3 controls the mode of the Time stamp' feature.

0 is the Continuous mode. Each signal is connected directly to the corresponding
highest bit of line counter.

1is Reset mode. Highest bits of the line counter are reset in the beginning of a new line.
In other words:
@ if R3.6=0, each signal is connected to the corresponding bit in the line counter

@ if R3.6=1, each signal is latched in RS trigger, which is reset in the beginning of each
line.

Programmable Outputs

Each programmable output pin can be programmed to the following output signals:

Snapshots: External Trigger Connector Pinout
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® TRG - Trigger signal output (for external device or second camera synchronization)

® STROBE - Refer to 1.3 Mpixel, 2 Mpixel or 3 Mpixel sensor data sheets for details

® EXTTRGRDY - Ready_for_triggering signal

® TRG_D - Delayed trigger signal output (delay and width are controlled via R8..R6
(delay), and R9 (width)

® FRAME_VALID - Refer to 1.3 Mpixel, 2 Mpixel or 3 Mpixel sensor data sheets for
details

@ LINE_VALID - Refer to 1.3 Mpixel, 2 Mpixel or 3 Mpixel sensor data sheets for details

® CLK- System clock

® Low level -Logic0

® High level - Logic 1

Signal controls are as follows:

® Pin2is controlled by bits [5,4,3] of R4
@ Pin3is controlled by bits [2,1,0] of R5
® Pin5 is controlled by bits [2,1,0] of R4

Pin control codes are as follows:

Pin2:

® TRG_D -[000]
® TRG - [001]

® EXTTRGRDY -[010]
® STROBE -[011]
e CLK - [100]

® STARTEXP -[101]
® Lowlevel -[110]
@ Highlevel -[111]

Pin3:
® STROBE -[000]

® TRG - [001]

® EXTTRGRDY -[010]
® TRG_D -[011]

® FRAME_VALID -[100]
e CLK -[101]

°

Low level -[110]

Snapshots: External Trigger Connector Pinout
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@ Highlevel -[111]

Pin5:

® TRG - [000]

® STROBE -[001]

® EXTTRGRDY -[010]
® TRG_.D -[011]

® FRAME_VALID -[100]
® LINE_VALID -[101]

® Lowlevel -[110]

® Highlevel -[111]

Important: Do not change any bits except mentioned above when writing pin control codes to registers R4, R5.

Global Reset Release (GRR) Snapshot Mode for MT9T001 Sensor (3Mpixels)

To setup the GRR Snapshot mode, follow the procedure described in the MT9T001
sensor data sheet. In addition, to enable the GRR mode, the application should set bit 2
of Altera register RO to "1’ in FPGA logic.

Note:  Itis necessary to reverse all changes before switching to video or Rolling Shutter snapshot modes.
Refer to Q37-GRR.GIF for explanation of control signals available at the external trigger
connector.
Strobe signal in different revisions of MT9T001 3Mp sensors is the following:
® rev.5649 - Strobe signal is present in both rolling and GRR snapshot modes
® rev.5665 - Strobe signal is present only in GRR snapshot mode

Configuring Outputs via the Interface
You can configure outputs directly from the application interface.

To configure outputs:

1 Press the Connector button in the Device Settings box.

¥ Direct Access Ta Driver Frame Memary  FrameRate ...
™ &uto White Balance Hardware
[~ &uto white Balance Software

Figure 6-5 Connector button

2 Select a control code for Pin2, Pin3 and Pin5:

Snapshots: External Trigger Connector Pinout
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External Connector Setup @
Fin2 Fin3 Pin

&+ [0]STROEE & [0]TRG
" [1]1TRG " [1]1TRG " [1]STROEE
" [2]EXTTRGRDY " [2]EXTTRGRDY " [2]EXTTRGRDY
" [3]STROEE " [3TRG_D " [3TRG_D
" [4]CLK " [4] FRAME_VALID " [4] FRAME_VALID
" [B]STARTEXP " [B] CLK " [B]LINE_VALID
™ [B] Lows level ™ [B] Lows level ™ [B] Lows level
™ [7]High level ™ [7]High level ™ [7]High level

Figure 6-6 External Connector Setup

Saving Snapshots

When you take snapshots, they are saved in directory and with file prefix specified in
Capture Options.

To change options for saving snapshots:

1 Open the Capture Options dialog by pressing Alt+c on the keyboard or go to the
File menu and select Capture Options.

SMX-MTx Capture Options @
Picture File Store Folder

C:\UszershlgortDeskioph gg

File Mame Prefizes

Single Frame |FRAME_ Fomat...

5 =0 " BMP

equence _

) @+ TIFF |NOME =
Yideo WIDED_ NONE
Snhapshot SMAR_ ZW'

Lirnits

[~ Capture single frame as average of |2 frames

[v Limit sequence count to |2 frames

I” Snapshot Save Onl
Capture a frame every |1 TS i 4

Capture Limit: {100
(] 8 | Cancel

Figure 6-7 Snapshot saving options

2 Set the options:

a. Inthe Picture File Store Folder box, change the directory in which you want to
save snapshots or leave the default one.

Note:  This folder will also store captured videos and frames.

b. Change the prefix that will be assigned to all snapshot files or leave the default
one. Use the Snapshot field. The files are named automatically by combining the
corresponding File Name Prefix and numerical value that is calculated by the
number of last captured file + 1.

Snapshots: Saving Snapshots
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c. Selectimage file format:
® BMP - saves any 8 bit or 10 bit image as 8 bit BMP image.

® TIFF - saves 8 bit image as 8 bit TIFF image and 10 bit image as 10 bit TIFF image.
Select also compression type: NONE (without compression) or LZW (Lemple-Zif-
Welch - lossless type of compression).

Note:  The selected image format will also be used for captured frames.

d. Check the Snapshot Save Only to save snapshots without showing them on the
screen.
e. Press OK.

Snapshots: Saving Snapshots
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Note:

Installation

WIA

You can get a picture from the SMX-M7x camera using the Scanners and Cameras
option - the standard Window's Administrative Tool (open Start> Control
Panel>Scanners and Cameras). You can use almost any image editing program to get
the image from the SMX-M7x camera using Scanners and Cameras.

The information in this section of the document is based on the image editor that is
always available in Windows XP - Microsoft Paint.

WIA operation with the camera is demonstrated in Windows XP operating system.

Note:

How it Works

To use the SMX-M7x camera for getting images, you should first install the required
software - TWAIN Driver.

If the TWAIN driver was installed during the SMX-M7x USB2.0 camera software package
installation (see “Installation” on page 9), it is ready to be used. If not, browse to the Sumix
folder where the software was installed and open the \SMX-M7x USB2.0
Camera\Drivers\TWAIN subfolder. Then run the SMXM7WiIA.exe file and wait awhile until
the installation is complete.

The TWAIN driver is installed and ready to be used now.

The TWAIN driver is not available yet for 64 bit Windows.

Location

Open the Control Panel window (Start>Control Panel), then open Scanners and
Cameras.

WIA: Installation
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Address B‘ Control Panel Go | Morkon Antivirus E -
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ControfRas] Accessibility Add Addor  Administr.., Date and Display Folder Fonts Game
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@) Help and Suppart "
Regional Scheduled Sound  Soundsand  Speech  Symantec System  Taskbar and
and La... Tasks Effect...  Audio De... Livelpdate Skark Menu
User
Accounts

Figure 7-1 The Scanners and Cameras item in the Control Panel window

Since TWAIN driver is already installed, the SMX-M7x USB2.0 Camera WIA should be
present there.

- WIA: How it Works
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r:} Scanners and Cameras E]@ﬁ
File Edit Wiew Favorites Tools  Help ,'
@ Back - _) ? 7 ) Search I Folders v
Address |'$ Scanners and Cameras |vi Go Morkon Ankivirus E -

—
Imaging Tasks S ‘3 SMK-M7 Series USE2.0 Camera
WIS

[3] Add an imaging device

»

Other Places

{} Control Panel

h:‘l My Documents
|5) Shared Documents
\3 Iy Metwork Places

Details ¥

Figure 7-2 Scanners and Cameras

Now you can use WIA to get images from the camera.

Getting Image Using the Scanner and Camera Wizard

To get the image using the Scanner and Camera Wizard:

1 Connect the SMX-M71M, SMX-M72 or SMX-M73 camera to your computer.
2 Open Control Panel>Scanners and Cameras.

3 Select the SMX-M7x USB2.0 Camera WIA and do one of the following:

® Right-click and select Get picture using Scanner Wizard

® Double-click the selection

WIA: How it Works
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'~ Scanners and Cameras ===
File  Edit View Favorites Tools  Help ;’:"

G Back ~ [ ? ,-. ! Search Folders Elv

fddress | =Y Scanners and Cameras | a Go | Morton Antiirus E =
Imaging Tasks = ""'--...__I SME-M7 Series LISEZ2.0 Camera
— g IS Scan
g Get pictures Get picture using Scanner Wizard
Wiew device properties Delete
Rename
Other Places & Properties

[ Control Panel

(L) My Documnents

) Shared Documents
\JJ Iy Metwork Places

<«

Details

Figure 7-3 Selecting the Scanner Wizard for getting image from the camera

4 Welcome to the Scanner and Camera Wizard will appear.

= Scanner and Camera Wizard

Welcome to the Scanner and Camera
Wizard

ST Series USB2.0 Camera WA

Thiz wizard helpz you copy pictures from your camera, scanner, or other
device to your computer, your network, or the Web,

To continue, click Next.

[ Mest> |[ Cancel ]

Figure 7-4 The Scanner and Camera Wizard welcome window

5 Click the Next button to go to the next step of the Scanner and Camera Wizard.

WIA: How it Works
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Z> Scanner and Camera Wizard
Choose Scanning Preferences ;,"
Choase your scanning preferences, and then click Preview ta see how your preferences affect

the picture.
Ficture type:
------------------------------------- |
Custom gettings E
B
[ < Back ” Mest » ] [ Cancel ]

Figure 7-5 The Scanner and Camera Wizard: selecting scanning preferences

6 Select Picture Type and adjust image settings:
@ Color picture - to get color image (for SMX-M72 and SMX-M73 models)

® Grayscale picture - to get black-and-white image (for SMX-M71M model)

® C(lick the Custom Settings button to adjust properties of the image:

Choose Scanning Preferences ;,/
Choase your scanning preferences, and then click Preview to see how your preferences affect [

the picture,

>

Ficture type: |

— Properties 3=
|
s | (5 Color pil -]
Advanced Properties 1
| o] @ {Ese Appearance
!‘Tl O i Brightness:
i,,. i J 24
Contrast:
-1
Cust - 2
Besolution [DF): Ficture type: - _li'
150 % iColor picture o

[ Ok H Cancel ] ahcel

Figure 7-6 The Scanner and Camera Wizard: the Advanced Properties window

7 Click the Preview button to view the image from the camera to be scanned.

WIA: How it Works



SMX-M7xx Series USB2.0 Camera User Guide

> Scanner and Camera Wizard

Choose Scanning Preferences
Choose your scanning preferences, and then click Preview to see how your preferences affect
the picture.

Ficture type:

(O Colar picture
(O Grayscale picture
(&) Custom

Custom gettings

|

[ <Back || Mest> |[ Cancel ]

Figure 7-7 The Scanner and Camera Wizard: previewing

8 Resize the image if needed.
9 Click the Next button to go to the next step of the Scanner and Camera Wizard.

> Scanner and Camera Wizard

Picture Name and Destination
Select a name and destination for your pictures,

1. Tuvpe aname for thiz group of pictures:

| Picture] [v]

2. Select a file format;

|54 BMP (Bitmap Image) vl

3. Choose a place to save thiz group of pictures:

|9 C:\Program FileshSumis ShA<M7x USB2.0 CamerahDATA || [CBrowse..

[ < Back ” Mest » ][ Cancel ]

Figure 7-8 The Scanner and Camera Wizard: picture name and destination window

10 Enter name, select file format and location where you want to save your picture.

11 Click the Next button - the Scanner and Camera Wizard starts scanning your pic-
ture.

WIA: How it Works
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Z> Scanner and Camera Wizard
Scanning Picture ;,"
Fleaze wait while the wizard scans your picture, [4

Location:

gram FileghSumixhShix-k 74 USE2 0 Camera\DATA

Picture:
Picture 004

N

Ficture progress: 100% complete

To stop copying, click Cancel.

Figure 7-9 The Scanner and Camera Wizard: scanning picture

12 After the Wizard finishes scanning the picture, you will be asked to select one of the
options. Select the last option and click the Next button.

= Scanner and Camera Wizard

Other Options
*Y'ou can chooge to keep working with your pictures.

“Your pictures have been successfully copied to your computer or network.
*f'ou can alzo publish these pictures to a Web site or order printz online.
‘what do you want to do’?

() Publizh these pictures to a'wWeb site
() Order prints of these pictures from a phato printing 'web site
(%) Mothing. I'm finished working with these pictures

Learn more about 0000 W DiciEs,

[ < Back ” Mest » ][ Cancel ]

Figure 7-10 The Scanner and Camera Wizard: other options window

13 View the last window of the Scanner and Camera Wizard and click the Finish but-
ton.

WIA: How it Works
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Z> Scanner and Camera Wizard

Completing the Scanner and Camera
Wizard

1 picture(s] were copied.

To zee your pictures on your computer or network,, click the location
below:
C:AProgram FileshS umitSbde-t4 74 ISBE2.0 CameratDATA

To cloze thiz wizard and zee your pictures, click Finish,

[ <Back |[ Finish |[ Cancel ]

Figure 7-11 The Completing the Scanner and Camera Wizard window

Microsoft Windows will open the folder where you saved the scanned image.

Getting Image Using Scan

To get the image using Scan:
1 Connect the SMX-M71, SMX-M72 or SMX-M73 camera to your computer.
2 Open Control Panel>Scanners and Cameras.

3 Right-click the SMX-M7x USB2.0 Camera WIA and select Scan (see Figure 7-12 Scan-
ners and Cameras: selecting Scan).

WIA: How it Works
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Figure 7-12 Scanners and Cameras: selecting Scan

4 A window with the list of available programs for image scanning will appear.

SMX-M7X Series USB2.0 Camera WIA

8]

Initiate & new scan.

Select the program ta launch for thiz action:

P
@ j Microsoft Office word

Microsoft Office word

_7 2 Microsoft Scanner and Camera Wizard
Download pictures from a camera or scanner

“\I_'T- Fhotoshop
25 Photoshop

[ &hways use thiz program for this action

[ ok

H Cancel ]

Figure 7-13 Select the program to launch for Scanning window

Some image editors that can be also used for scanning images might not be present in the list that is displayed. It

might be due to the current operating system settings or the image editor configuration. For more information,
see Help Topics of Windows operating system about Scanners and Cameras or Help Topics of the image edi-

tors.

5 Select the program most suitable for you and click the OK button - the selected pro-
gram will start and Scan Using SMX-M7x Series USB2.0 Camera WIA will open.

WIA: How it Works
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Note:

> Scan using SMX-M7X Series USB2.0 Camera WIA )=

What do you want to scan?
Select an option below for the type of picture pou
want to scan.

: s =
E' (O Grayscale picture
(O Custom Settings
“f'ou can also: |i- ----------------------------------- -|Ii
Adjust the guality of the scanned picture

[ Freview ] [ Scan ] [ Cancel ]

Figure 7-14 Scan using SMX-M7x Series USB2.0 Camera WIA window

Not all image editors open the Scan Using SMX-M7X Series USB2.0 Camera WIA window automatically -
some of them just open the program's main window. It depends on the program configuration. In this case, for
more information see Help Topic for this program.

6 Select Color or Grayscale picture or click the Adjust the quality of the scanned
picture link to change the image settings. Click the Preview button to preview the
image to be scanned.

7 When ready, click the Scan button - the image editor will start scanning and will
show the scanned image in the current program’s window.

Getting Image Using Microsoft Paint

WIA: How it Works

To get the image from the camera using Microsoft Paint:
1 Open Microsoft Paint (Start>All Programs>Accessories>Paint).
2 Connect the SMX-M71, SMX-M72 or SMX-M73 camera to the computer.

3 In Microsoft Paint, open File>From Scanner or Camera... - Scan Using SMX-M7x
Series USB2.0 Camera WIA will open.
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For Help, click Help Topics on the Help Menu.

Figure 7-15 Getting image from the camera using Microsoft Paint

81,116

4 Adjust the image settings, click Preview to view the image that is scanning.

5 When ready, click the Scan button.

6 When done, save the scanned image.

WIA: How it Works
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Figure 7-16 Microsoft Paint: Image received after scanning

Note  To get more information about the Scanners and Cameras operation, see standard Window's XP Help Topics
about it

WIA: How it Works



Chapter 8

-CUT FILTER

The SMX-M72 and SMX-M73 color cameras can be supplied with an IR-cut filter:

The IR-cut filter provided with the camera has the following characteristics:
® Diameter = 20mm
® Thickness =2 mm

Chart of the IR-cut filter transmission characteristics:

Reutrirer: [
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When to Use

The IR-cut filter can be used for both color and monochrome SMX-M7x cameras.

Using IR-cut Filers with SMX-M7x Color Cameras

IR-cut filter is a color filter that blocks infrared light. Since the SMX-M7x color cameras
are sensitive to IR-light, use the IR-cut filter with color camera models to make colors of
the image more realistic.

Many light sources, including the sun, emit infrared light, so the color camera in daylight
will see a significant amount of infrared light without the IR-cut filter. As a result, strange
and non-realistic colors appear.

IR-cut Filter : When to Use
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How to Use

SMX-M7xx Series USB2.0 Camera User Guide

Another reason for using the IR-cut filter is the limited color correction for many lenses.
A lot of lenses have different depth of focus for visible and infrared spectrum. The IR-cut
filter cuts away a significant amount of the overall collected light and thereby affects the
sensitivity in a negative way. In general, color cameras are one factor less sensitive
compared to monochrome (depending on the sensor). This is primarily due to the IR-cut
filter.

When the camera is used with the IR-cut filter, the focus distance is increased to 0.66mm. To restore the focus dis-

tance to the original value (when the camera is used without the IR-cut filter ring and ring-adapter) we suggest
using a ring-adapter:

N

Usually the camera is supplied with the IR-cut filter screwed in.

The procedure of screwing the IR-cut filter in, and using the ring-adapter is described
below.

Install the IR-cut filter in the following way:
1 Remove the cover from the camera.
2 Put the IR-cut filter to the camera so that two holes of the filter are on top:

IR-cut Filter : How to Use
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3 Use a needle-like tool (e.g. tweezers) and screw the IR-cut filter in:

Note:  The latest SMX-M7x color cameras have blocking elements on the inner thread to avoid the IR-cut filter falling on
the sensor. The previously manufactured cameras do not have these blocking elements, so when screwing the IR-
cut filter into these cameras, make no more than 10-11 full turns.

IR-cut Filter : How to Use
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4 Once the IR-cut filter is screwed in, put the ring-adapter as shown in the picture:
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5 Screw thelensin:

Please note that when the camera is used without the IR-cut filter, it is recommended to
remove the cover and screw the lens in (as well as to screw the lens out and put the
cover on) when the camera is faced down - to prevent contamination of the sensor.

IR-cut Filter : How to Use
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To screw the lens in the camera that contain no IR-cut filter, put the camera facing down
and do the following:

1 Remove the cover.
2 Putthelensin.

screw the

¢ > remove the
lens in

cover

To screw the lens out of the camera that contains no IR-cut filter, put the camera facing
down and do the following:

1 Screw the lens out.
2 Put the coveron.

IR-cut Filter : How to Use
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screw the

Note:  Before screwing the lens in or putting the cover on, make sure that its surface is free from the dust. When you
remove the cover put it facing down to keep the dust out

&

IR-cut Filter : How to Use -
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TRIGGER CONNECTOR

This chapter describes how to use a Hirose trigger connector and cable with a SMX-
M7xx Series camera. Hirose trigger connector is included in the standard camera kit.
Since a cable is not included in the standard connector package, this document will
guide on how to use the connector with a cable.

Soldering of Connector with Cable

A cable should be soldered to the connector according to the pin layout (see “External
Trigger Connector Pinout” on page 50).

Prepare a standard (6-core) cable with already opened contacts for soldering with the
connector.

=

Figure 9-1 A cable for soldering with the connector

Prepare a tweezers-like tool for the connector assembling.

Trigger Connector
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Trigger Connector

Figure 9-2 Tweezers tool for the connector modifying

Unscrew the rear part of the connector.

Rear part of the
connector

Main part of
the
connector

Figure 9-3 The rear part and the main part of the connector

Use tweezers and remove it from the main part in the following way:
1 Fix the inner part of the connector with tweezers.
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Figure 9-4 Fixing of the inner part of the connector with tweezers

2 Unscrew the rear part of the connector with fingers clockwise.

Trigger Connector
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Figure 9-5 Unscrewing of the rear part of the connector

Trigger Connector



SMX-M7x Series USB2.0 Camera User Guide

3 Remove the rear part of the connector from the main part.

(>

Figure 9-6 Removing of the rear part of the connector from the main part

Unscrew the inner part of the connector:

Inner part , Main part of
of the the
connector | connector

Figure 9-7 The inner part and the main part of the connector

To unscrew, perform the following steps:
1 Hold the main part of the connector with your fingers.

Trigger Connector
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Figure 9-8 Gripping the main part of the connector with fingers

2 Fix the inner part of the connector with tweezers (see Figure 9-4 Fixing of the inner part

of the connector with tweezers).

3 Rotate tweezers counterclockwise.

Trigger Connector
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Figure 9-9 Unscrewing the inner part of the Connector from the main part

4 Remove the inner part of the connector from the main part.

Trigger Connector



SMX-M7x Series USB2.0 Camera User Guide

23

Figure 9-10 Removing the inner part of the connector from the main part

As a result, all connector parts will be disassembled:

O )00 (0

Figure 9-11 All parts of the connector are disassembled

Insert a cable into the rear part of the connector.

Trigger Connector
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Figure 9-12 Inserting of a cable in the rear part of the connector

Then insert it into the main part.

B =

Figure 9-13 Inserting of a cable in the main part of the connector

When a cable is inserted into the rear part and the main part correspondingly, solder
each pin of the connector with opened contacts of a cable according to the layout (see
“Soldering of Connector with Cable” on page 77) and your specific needs:

31 i m—

Pins of the Opened contacts
connector for of a cable for sol-
soldering dering

Figure 9-14 Inserting and soldering of a cable to the inner part of the connector

Trigger Connector
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Please note that each pin is marked with a number according to the pin layout (see
“Soldering of Connector with Cable” on page 77). The pins numbering is located at the
internal side of the inner part of the connector.

Figure 9-15 Connector pinout outlook

Note also that direction of pin numbering is done clockwise starting from the key at the
upper edge of the inner part of the connector.

Key: the start point of pin num-

bering
~ Shows the direction of pin
numberin
é@(}] 9
O 39?

Figure 9-16 The pin numbering direction

When the soldering is done, insert the inner part of the connector in the main part.

Trigger Connector
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Figure 9-17 Inserting of the inner part of the connector in the main part

Screw in the inner part of the connector in the following way:
1 Fix the inner part of the connector with tweezers (see Figure 9-4 Fixing of the inner part

of the connector with tweezers).

2 Hold the main part of the connector with fingers.

Figure 9-18 Gripping of the main part of the connector with fingers

3 Screw the main part of the connector in counterclockwise.

Trigger Connector
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Figure 9-19 Screwing the inner part of the connector in

Insert the main part of the connector into the rear part.

Figure 9-20 Inserting of the main part of the connector into the rear

Screw the rear part in using tweezers in the following way:
1 Fix the inner part of the connector with tweezers (see Figure 9-4 Fixing of the inner part

of the connector with tweezers).

2 Screw the rear part of the connector in with your fingers counterclockwise.

Trigger Connector
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Figure 9-21 Screwing of the rear part of the connector in to the main part

Connector is ready to be used.

Figure 9-22 Soldered connector with a cable

Trigger Connector
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KEYBOARD SHORTCUTS

Keyboard Description
shortcut
F1 Help
F2 Captures a frame into bitmap file
F3 Captures a sequence of frames into bitmap files
F4 Captures a sequence of frames into AVl file
Shift + F4 Captures a sequence of frames to the memory
F5 Starts live video display in the View window
Shift+F5 Stops live video display and closes the View window
F9 Takes a snapshot
F12 Brings up the Main window when displaying the live video
Esc Same as Shift + F5, stops the video
Ctrl+ 0 Opens Camera Profile
Ctrl +S Saves Camera Profile
Ctrl+C Copies an image from the camera to buffer
Alt+C Brings up the Capture Options dialog box
Alt+S Brings up the Device Settings dialog box
Alt+V Brings up the Viewport Settings dialog box
H Brings up the Histogram
w Performs White Balance (Soft) using Color Balance
Alt+W Performs White Balance (Hard) using Gain Controls
Numpad +/- Zoom In/Zoom Out the picture in the View window
Numpad * Restores the picture in the View window to its original (100%) size

Keyboard Shortcuts:
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Keyboard Shortcuts:



TOOLBAR OVERVIEW

The most common menu commands are duplicated on the application toolbar:

Starts live video display in the View window
Stops live video display and closes the View window
Brings up the Viewport Setup dialog box
Captures a frame into BMP/TIFF file
Captures a sequence of frames into BMP/TIFF files

Starts saving Video to afile

2 [ ]e |8 |= [o |

Starts saving Video to memory

Toolbar Overview:
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